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1 Features overview

1.1 Netop Class Management overview

Netop School Class Management includes two Netop modules:

Netop Class Manager that manages a class database, and 

Netop Class Server that provides class information from the class database to Netop
Teachers and Netop Students.

When Netop Teachers and Netop Students use Class Management with a Class Server and
a Class Manager, the communication between the various components is as illustrated
below:

1a. and 1b.
Request Class
Information

When Teachers or Students end a class, they will automatically
request class information from Netop Class Server. 

2. Query Class
Database

When Netop Class Server receives a class information request, it
queries the class database for information for the requesting
Teacher or Student.

If the Netop School Class Management class has been set up to
run in scheduled mode, it returns lesson information. 

If the Netop School Class Management class database has been
set up to run in non-scheduled mode, it returns course information.
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3a. and 3b.
Return Class
Information

Netop Class Server returns the retrieved information to the
requesting Teachers or Students.

4. Connect Teachers display a Select Class window with either scheduled
lessons to select one to run, or courses to select one to run.

Students displaying the Select Class window enable the user to select a lesson to
connect to or a course to connect to. If the lesson or class is not running, Netop Student
will wait for it to start and then automatically connect. 

The user can also select <Available for any class> to automatically connect to any
class to which the Student is assigned or wait for one to start; this enables a Teacher
running a class to connect the Student to the class.

Students not displaying the Select Class window will automatically connect to any class
to which they are assigned or wait for one to start; this enables a Teacher running a
class to connect the Student to the class.

Netop Class Manager manages the class database.

1.2 Netop Class Manager

The Netop Class Manager Window is the main user interface for managing the class
database.

The work panel has a list of terms, a calendar, a courses section and - to the left - a
classrooms section.

Select a term in the Term list  to display the corresponding calendar. Select a date in the
term calendar to display the lessons of the selected date in the Classrooms section .
The Courses section contains lists course groups and courses.

The class database contains interrelated tables of terms, teachers, teacher groups,
students, student groups, courses, course groups, classrooms, classroom groups,
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timetables and lessons.

A term specifies a date range within which courses can be specified and course lessons
can be scheduled in classrooms.

A teacher that can be assigned to a teacher group identifies a Netop Teacher.
Teachers and teacher groups can be assigned to courses.

A student that can be assigned to a student group identifies a Netop Student. Students
and student groups can be assigned to courses.

A course that is assigned to a course group specifies the subject, identifying color and
members of a series of classes. Course members are teachers, teacher groups, students
and student groups.

A classroom that is assigned to a classroom group specifies a physical or virtual venue
of lessons.

A timetable specifies a daily time range of lessons, optionally including fixed lesson
schedules.

A lesson that is named and colored by the course it is part of specifies a scheduled
non-recurring or recurring class of a course in a classroom.

You can create classrooms in classroom groups, teachers, students, courses in course
groups and lessons by import from an external data source. You can assign teachers and
students to groups by import from an external data source.

1.3 Netop Class Server

Net0p Class Server is an extended Netop Remote Control Host that can provide class
information from a class database to Netop Teachers and Netop Students.

Netop Class Server has full Netop Host functionality, which enables a Netop Class Server
computer to be remote controlled from a computer running Netop Guest.
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1.4 Computer resources

Netop Class Manager and Netop Class Server must run on networked Windows computers.
In a small setup both modules can run on the same computer but in a large setup, Netop
Class Manager should run on one or multiple class administrator workstations and Netop
Class Server should run on multiple computers for backup and load balancing.

The class database must run in an OLE DB accessible database. To try out Netop School
Class Management, a local test database can be created on a computer running Netop
Class Manager and Netop Class Server.
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2 Install Class Management modules

2.1 Installation prerequisites and tips

Class Manager Class Manager must be installed on a Windows NT4+ (Windows 7,
Vista, XP, 2000 or NT4) computer.

To use Netop Class Manager, Microsoft .NET Framework version 1.1
must be installed on the computer. If not found on the computer,
you will be referred to the Microsoft website to download and install
a redistributable version of .NET Framework version 1.1.

Class Server Netop Class Server must be installed on a Windows NT4, Windows 95
or newer Windows computer. 

The use who installs must have administrator rights on the
computer. 

For backup and load balancing purposes, we recommend that you
install Class Server on multiple computers.

Netop Class Server must be installed on a computer which is not
simultaneously running a Teacher or a Student module: Class Server
cannot service a Netop School module running on the same
computer.

2.2 Install Class Manager and Class Server

Class Manager and Class server are both installed from the Netop School download page
on the Netop site.

Install Class Manager

1.Click the download link on the Download Netop School6 page.

2. In the File Download dialog box, click Save to download the installation package and
install from a local computer, or Run to start the installation immediately.

3. When the installation is running, follow the installation wizard instructions.

When the installation is complete, Netop Class Manager starts automatically. To begin
using the complete Class Management system, a few setup steps necessary both in the
Teacher and Student modules as well as in the Class Server and the Class Manager
modules. 

If you have not already installed Class Server, please proceed to do so; see below for
brief installation instructions. 

When both Class Server and Class Manager modules have been installed, you can proceed
to setup; refer to Basic setup steps for details.

Install Class Server

Follow the same steps as described above for Class Manager, but click the download link
for the Class Server on the Download Netop School6 page. 
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When the installation is complete, Netop Class Server starts automatically and opens the 
Class Server Setup dialog box; refer to Basic setup steps for details.



Set up Class Management

9

3 Set up Class Management

3.1 Basic setup steps

When the standard Netop School modules, Teacher and Student, have been installed as
well as the advanced Class Server and Class Manager modules, the modules must be set
up to connect to each other. 

Below are the basic setup steps:

1. In the Teacher module: Set up the Teacher module to use Class Server.

2. In the Student module: Set up the Student module to use Class Server.

3. In the Class Manager module: Select a database.

4. In the Class Server: Define a name for the Class Server and connect to the same
database that you selected in Class Manager.

When these steps have been complete and both the database and Class Server are
running, Netop School Class Management can run automatically and unattended.

If Netop School Class Management fails to respond to Teacher and Student class
information requests as intended, look into Netop Class Manager to see if the class
database setup needs to be changed and look into Netop Class Server setup to see if it
needs to be changed. 

Before the start of a term, you must work with Netop Class Manager to specify the
courses and possibly lessons and new teachers and students of the term. After the end of
a term, you can clean up the class database of old term class data, see Clean Up
Database.

3.2 Set up Teacher and Student

Class Server is an optional module and by default the Teacher and Student modules do
not use Class Server to manage class connections.

Set up the Teacher module to use Class Server

1.On the Tools tab, in the Startup group, click Class.

2. Select the Use Class Server check box and click Setup to define Class Server
setup.

Specify an IP address if the School modules are not on the same subnet.

Select how the Teacher computer should be identified. Note that you must identify a
Teacher computer in the same way in Class Manager.

Set up the Student module to use Class Server

1.On the Tools menu, click Options and then double-click Class.

2. Select the Use Class Server option and click Setup.

The options are almost identical to the Teacher module options described above and the
same considerations about identification apply.
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3.3 Select a database

Before you can begin working with Class Management you need to select the database
where you will be storing data about teachers, students, classes and classrooms. 

When you start Class Manager for the first time, the Database Management dialog box
to select a database automatically displays.

If you are trying out Class Management or do not currently have a administrator access
to an actual database, click Use Test Database.

If you want to set up an actual database click Update.

Use a test database

A test database is a Microsoft Office Access file named ClassSrv.mdb which is
created in your personal folder.

When you have selected to use a test database, you can immediately start using the
Class Manager to enter test data.

About using a test database

Note that a test database is meant for testing only and you should not rely on a test
database for storing vital class management data. If the test database becomes
inaccessible, it will be deleted and re-created and consequently any stored data will
be lost.

The test database requires that the Microsoft Jet 4.0 database engine and a current
version of Microsoft Data Access Components (MDAC) are installed on the computer.
Downloads are available from www.microsoft.com.

To avoid any file access issues, run Netop Class Manager and Netop Class Server
modules on the same computer.

Use an actual database

1.On the Tools menu in Class Manager, click Database Management.

2. In the Database Management dialog box, click Change.

If you are trying out Class Management or do not currently have a administrator
access to an actual database, click Use Test Database. For additional details,
see below.

3. In the Data Link Properties dialog box, on the Provider tab, select the
provider of the database that you will be using and click Next.

If using an SQL server, select Microsoft OLE DB Provider for SQL Server. If using
another type of database, select the OLE DB provider matching the type of
database.

4. On the Connection tab, specify setting for the database connection. 

The specific settings differ according to the provider selected on the Provider tab
but typically include server name, database name and password.

Optionally, click Test Connection to test that the information you have entered is
sufficient and correct.

When you click OK, the connection is established and an empty database is created.
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About the class database

The class database can reside in any OLE DB (Object Linking and Embedding
DataBase) accessible database.

If an OLE DB accessible database is available on the network, we recommend using
it. If no OLE DB accessible database is available on the network, we recommend
downloading and installing Microsoft SQL Express 2005 or 2008 from www.microsoft.
com.

NetOp School Class Management is optimized for using a Microsoft SQL Server
database. If you are using Microsoft SQL Server, in the SQL Server Network Utility
window clear Named Pipes to apply only TCP/IP.

The database must be running to enable NetOp School Class Management to use it.

3.4 Connect to database

Class Server also needs to connect to the class database to that it can service Teacher
and Student modules with class information. When you start Class Server for the first
time, the Class Server Setup dialog box to provide the necessary setup information
automatically displays.

In the Class Server Setup dialog box, do the following:

Leave the Enable check box selected.

In the Class server ID field, type the name that both Teacher and Student modules
use to identify the server.

In the Database connect string field, type database identification. Tip:  The easiest
way to fill in the information is to copy the string from the Class Manager where you
just selected a database. Alternatively, click Setup to select provider and define
connection properties.

If database access is password protected, type the user name and password in the
appropriate fields. 

Use the Test button to verify that Class Server can communicate with the database.

Tip

To open the dialog box when it does not automatically display: On the Tools menu, click
Class Server Setup.

After the initial setup described above, the Netop Remote Control Setup Wizard will run to
set up the Netop Host functionality of Netop Class Server. We recommend that you use
the wizard default options.

http://www.microsoft.com.
http://www.microsoft.com.
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4 Use Class Manager

4.1 Class Manager components

Class Manager is the interface to interrelated components in the class database. Because
the component are interrelated and depend on each other, they must be created in a
certain sequence. For example, a term must be created before courses or a timetable can
be created. The sequence in which the components must be created is given by the
sequence of the components buttons on the toolbar: Term, Teacher, Student, Student
Groups, Course, Classroom and Timetable. You will see that commands and buttons that it
does not make sense to use because the components that are prerequisites have not
been created are unavailable. For example, Student Groups cannot be created until
Students exist.

The Class Manager Components can either be created using the dialog boxes in the Class
Manager, or they can be imported from external comma-separated values (CSV) files.
They can also be created using a combination of the two methods. Import will only be
successful if the necessary components already exist and the import will give an error
message if you try to import, for example, course data before a term has been created. 

This means that whether you choose to create components in the Class Manager or to
import from an external file, Class Manager ensures data consistency.

Below sections include descriptions of the database components and information about
specific rules or tips that may apply to creating each.

Terms

A term is a data range within which courses can be created and lessons can be
scheduled. A term is frequently a full year or a semester.

Typically, you will specify the current term when initially loading Netop Class
Manager. You can create more terms later.

Note

Terms cannot overlap.

Select a term in the Term list to display its calendar, courses and lessons in the
Class Manager window work panel.

A term can support one of two class modes. Non-scheduled mode provides course
information to teachers and students requesting class information. Scheduled mode
provides scheduled lesson information. You can switch the class mode of a term at
any time.

To start up Netop School Class Management quickly and easily, use non-scheduled
mode specifying only teachers and courses. Let teachers assign available students to
courses while running in non-scheduled mode.

See Also

Class modes

Teachers

Class Manager specifies teachers and teacher groups to identify Netop Teachers as
course members.
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Create at least one teacher; you can create more teachers later.

You can create teachers by import from an external data source.

You can assign teachers to teacher groups.

Teachers and teacher groups are available in all terms and are assigned to courses.

Students

Class Manager specifies students and student groups to identify Netop Students as
course members.

You do not need to specify students to create courses. However, to enable testing
how Netop School Class Management works, create at least one student. You can
create more students later.

You can create students by import from an external data source.

Note: A Netop Teacher can create a student by connecting an available Netop
Student to the running class.

You can assign students to student groups. 

Students and student groups are available in all terms and are assigned to courses.

Courses

Class Manager specifies courses to identify the subjects and members of classes.
Netop Class Manager can specify lessons as scheduled classes of courses in
classrooms.

Create at least one course; you can create more courses later.

Note

To create a course, at least one Term and one Teacher must exist.

A course is always assigned to a course group. Initially, a default course group
named Default Group exists.

You can create courses assigning them to one course group or assigning each of
them to a specified course group by import from an external data source.

Courses and course groups are available only in the Term in which they were created
in the work panel Courses section. Click [+] buttons to expand and [-] buttons to
collapse course groups.

Netop School Class Management can support two class modes, non-scheduled mode
and scheduled mode. Non-scheduled mode enables Netop Teachers to run non-
scheduled classes of courses. Scheduled mode enables Netop Teachers to run
scheduled lessons of courses in classrooms.

To run a simplified Netop School Class Management setup supporting only non-
scheduled mode, you do not need to specify Classrooms and Lessons.

Classrooms

Class Manager specifies classrooms as venues for lessons.
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A Netop Class Manager classroom typically refers to a physical classroom with
teacher and student computers that can connect for teachers and students to
engage in educational activities in a lesson. However, a Netop Class Manager
classroom can just as well refer to a virtual classroom where teacher and student
computers in different physical locations can connect.

To support scheduled mode, create at least one classroom; you can create more
classrooms later.

A classroom is always assigned to a classroom group. Initially, one classroom group
named Default Group is available.

You can create classrooms assigning them to one classroom group or each to a
specified classroom group by import from an external data source.

Classrooms and classroom groups are available in all terms in the Class Manager
window work panel.

To display or hide classroom group names in the Classrooms section, right-click
anywhere in the area and select Show Groups or Hide Groups. If classroom groups
are displayed, click [+] buttons to expand and [-] buttons to collapse them.

Timetables

Class Manager specifies timetables as daily time ranges within which lessons can be
scheduled.

The applied timetable determines the initial time range of the Class Manager window.

Within a timetable, you can specify fixed lesson schedules to align lessons with your
customary timetable.

Initially, a default timetable named Default Group with a time range from 8:00 A.M.
to 4:00 P.M. and a floating lesson schedule is applied. 

Timetables are available in all Terms in the Timetable window.

We recommend using a timetable with fixed lesson schedules.

Lessons

Class Manager specifies lessons as scheduled classes of courses in classrooms.

To support scheduled mode, create at least one lesson by dragging a course from
the Courses section to a classroom schedule bar.

Note

To create a lesson, at least one course and one classroom must exist.

Lessons are available only in the term in which they were created.

To rescale the schedule panel horizontally, drag horizontally above the schedule
panel. To scroll the schedule panel horizontally, press CTRL and drag horizontally
above the schedule panel.

To display the schedule panel of another term date, click the date in the term
calendar.

To print the classrooms section, click Print on the File menu.
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4.2 Class modes

One of the basic decisions you need to make when starting to use Netop Class
Management is whether you want to use scheduled or non-scheduled class mode.

If you choose non-scheduled class mode, Class Management provides course information
to Teachers and Students waiting for a class whereas time and place information is not
provided. Non-scheduled class mode is simple to set up and to maintain since only courses
need to exist whereas classrooms, timetables and lessons are not needed. Non-scheduled
mode is typically used in teaching environments where students form groups and are
taught in the same groups, like for example in primary or elementary school.

If you choose scheduled mode, Class Management provides lesson information, including
information about classroom and time, to Teachers and Students waiting for a class.
Scheduled class mode requires that you define classrooms, timetables and lessons. This
information is typically available in a timetable planning system, exported from there and
then imported in Class Manager. This means that when you use scheduled class mode,
you will likely need to synchronize Class Manager and timetable planning information on a
regular basis. Scheduled mode is typically used in teaching environments where students
are not necessarily part of a class but join different lessons on an individual basis, like for
example colleges or universities.

Class mode is set up for each term and is defined in the Edit Term dialog box.

You can see which mode is currently used in the Class Manager status bar. Also, the
background color for the schedule panel differs in the different modes.

4.3 Import data from a CSV file

Basically there are two ways to enter data into the Class Management database: entering
data manually using the Class Manager or importing data from a CSV file.

The import commands are on the File menu; you can choose to browse for multiple CSV
files using the Multi Import command, or you can import from one CSV file at a time using
the Import From File commands.

Regardless of which import you use, two requirements apply to the data import:

Data must exist in the correct format in the CSV file.

For general information about the CSV file format, see CSV file requirements. For
information about the required and optional fields for each component type, see the
description of each import on the File menu.

Data must be imported in the right sequence for the import to be successful.

Data build on each other and the import must happen in a certain sequence. For
example, teacher data must exist before course data is created and a teacher is
assigned to a course.

4.4 CSV file requirements

These general requirements apply to CSV files used by Netop Class Manager:

There are no requirements to CSV file names, extensions and locations. However, we
recommend to use CSV file names that identify the association of the file to a particular
type of import operation and use the extension csv to identify files as CSV files or txt to
identify files as plain text files.
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Syntax

For import operations to succeed, CSV file syntax requirements must be observed.

Values can be separated by commas or semicolons.

Required values must specify a string of characters. Optional values can specify a string
of characters or not.

Do not omit required commas or semicolons before and after a value not specifying a
string of characters that is followed by a value specifying a string of characters in the
same line.

Values

Specify values only by characters that belong to the ASCII character set.

In values not enclosed by double quotation marks (“), do not use commas (,), semicolons
(;), single (‘) and double (“) quotation marks. Spaces are allowed.

In values enclosed by double quotation marks (“) indicating that the value is what is
enclosed, do not use double quotation marks (“).

Special format requirements apply to time, date and certain other values. Other values
are truncated after a specified number of characters, meaning that characters after the
specified number of characters are disregarded. These numbers that are specified when
the class database is created can be changed by the database administrator.

4.5 Work panel

The work panel contains an upper right Term list, a term calendar, a Courses section
and - to the left - a Classrooms section.

Term list

The Term list is located in the upper right corner of the work panel and displays the
name of the selected term. 

Existing teachers, teacher groups, students, student groups, course groups,
classrooms, classroom groups and timetables are available in all terms. Existing term
calendar dates, courses and lessons are available only in the term in which they are
specified.
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Term calendar

The calendar is locate in the middle right of the work panel and displays a month in
the term selected in the Term list.

The title bar displays the month and year. Click the left button to display the
previous month. Click the right button to display the next month. Months outside the
term cannot be displayed.

The calendar area displays the dates of the month in weekday columns. Click a date
within the term to highlight it with a blue background to display its scheduled lessons
in the Classrooms section.

The computer calendar current date is marked by a red rectangle. Below the calendar
the current date is displayed with the rectangle symbol.

Courses section

The Courses section is located in the lower right corner of the work panel and
displays existing course groups expanding into courses existing in the selected term.

Expand or collapse course groups by clicking the [+]/[-] buttons.

Courses display the course background color.

Right-click a course to open a menu where you can:

Create a new course.

Edit the selected course.

Delete a course or course group.

View the course dialog box.

View the lessons in the selected course.

Classroom section

The Classrooms section is located to the left in the work panel and consists of a
the classrooms bar and the schedule panel.

Right-click an item in the Classrooms section to open a menu where you can:

Create a new classroom.

Edit the selected classroom.

Delete a classroom.
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View the classrooms dialog box.

Show or Hide groups in the Classrooms panel.

The schedule panel displays a time range with vertical hour lines. The initial time
range is determined by the applied timetable.

To rescale the time range, drag horizontally above the schedule panel. To scroll the
time range, press CTRL and drag horizontally above the schedule panel.

Each classroom in the Classrooms bar has a horizontal schedule bar in the schedule
panel. Lessons scheduled in a classroom on the selected day are represented by
named and colored lesson blocks. The horizontal length of a lesson block represents
the time that the lesson uses the classroom. If multiple lessons use a classroom at
the same time, their lesson blocks share the classroom schedule bar. 

4.6 Create and edit a lesson

To create a lesson, drag a course from the Courses section to the classrooms schedule
bar and drop it to create a non-recurring lesson at the dropped time position. If the
applied timetable specifies fixed lesson schedules, the lesson will be aligned to the fixed
lesson schedule at the dropped time position.

You can edit a lesson using drag-and-drop or from a shortcut menu.

Edit a lesson using drag-and-drop

Note:  You cannot edit an ended lesson.

Move a lesson to another schedule panel time position or classroom schedule bar by
dragging the lesson block.

Change the length of a lesson by dragging the left or right end of the lesson block.

If you are editing a recurring lesson, this window will be displayed:

Click Yes to close the window and apply changes to all future occurrences of the
selected lesson.

Click No to close the window and apply changes only to the selected occurrence of
the selected lesson making it non-recurring.

Edit a lesson from a shortcut menu

Right-click a lesson block and click Edit Lesson on the shortcut menu.
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Notes

No dialog box options are available if the Status of the selected lesson is
Completed.

All dialog box options except Delete are unavailable if the Status of the selected
lesson is Passed or Called Off.

If the selected lesson is recurring, you will be asked if changes should apply to all
future occurrences of it unless you select the Change this lesson only check box.

Use the dialog box options to change the current lesson selections.

The lesson Status can be one of the following:

Completed: The lesson with a running class has ended.

Passed: The lesson with no running class has ended.

Called Off: The lesson has been called off.

Ongoing: The lesson is ongoing.

Extended: The lesson has been extended and is still ongoing.

Upcoming: The lesson is scheduled to start in the future.
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5 Class Manager menus and dialog boxes

5.1 File menu

Print... Prints the classrooms section with classrooms and time slots when
each one is used.

This can be useful to provide documentation for classroom utilization.

The size of the printout depends on the printer type and paper size.
Adjust Scale (25-500) and Width (0-750) to fit the printout to the
printer type and paper size.

Multi Import Import one or more types of component data from a comma-
separated values (CSV) file.
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Click the relevant Browse button and locate the file to import.

Use Import All to execute the selected imports sequentially from top
to bottom. When a selected import operation has been completed,
the check mark next to it is removed. If the execution is stopped by
an error, the error must be corrected before the import can be
resumed.

See Also

General CSV file requirements: CSV file requirements.
Individual CSV file requirements: Import Teachers from file, Import
Students from file, Import Classrooms from file, Import lessons from
file.

5.1.1 Import Teachers from File

On the File menu, point to Import From File and then click Teachers.

Use the Import Teachers from File dialog box to import teacher data from a CSV file.

1. Create your CSV file according to the import format described in the dialog box and
below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the data
before doing the actual import. Any errors are marked as such and an error message is
shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click Edit
and Import.

To exclude one or more records from the import: Select the records, then right-click
and click Exclude.

Import format

The CSV file with teacher data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required
or
Optional

Max # of
characters

Import description

<Teacher> Required 64 The teacher name.

If <Teacher> and <Teacher Foreign ID> are
identical to existing teacher data, the
existing data will be overwritten.

If only one of either <Teacher> or
<Teacher Foreign ID> is identical to existing
teacher data, the imported data will result
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Value Required
or
Optional

Max # of
characters

Import description

in new teacher data.

Note: Identical <Teacher> values for
different teachers are allowed but not
recommended.

<Teacher
Foreign ID>

Optional 64 This data is used only if you want identical
<Teacher> values for different teachers.

<Comments> Optional 64

<Windows
Logon Name>

One of
these three
values is
required to
uniquely
identify the
teacher.

250 Import always preserves data consistency:
if an import would cause any teacher
Windows Logon Name, Computer Name or
Teacher Profile values to become
duplicated, import will be denied.

<Computer
Name>

250

<Teacher
Profile>

250

Sample data

Dr. Nelson,T1001,English teacher,NN,,

Mrs. Schmidt,T1002,German teacher,MES,G04,

Mr. Jones,T1003,”Replacement for Mrs. Schmidt”,,,Herbert

<Teacher
>

<Teacher
Foreign ID>

<Comments> <Windows
Logon
Name>

<Computer
Name>

<Teacher
Profile>

Dr. Nelson T1001 English teacher NN

Mrs. SchmidtT1002 German teacher MES G04

Mr. Jones T1003 ”Replacement for
Mrs. Schmidt”

Herbert

5.1.2 Import Teachers to Groups from File

On the File menu, point to Import From File and then click Teachers to Groups.

Use the Import Teachers to Groups from File dialog box to import teacher data into a
group from a CSV file.

Select the One Group tab to assign teachers to one teacher group

Use the Import settings to specify whether you want to import teacher data into
an existing teacher group or create a new group.

1. Create your CSV file according to the import format described in the dialog box
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and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with teacher data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import description

<Teacher
Foreign ID>

Required 64 If no existing teacher is
identified by this <Teacher
Foreign ID> value, the
assignment of the teacher to
the specified teacher group
will be denied.

Sample data

T1001

T1002

T1003

Select the Multiple Groups tab to assign teachers individually to multiple
teacher groups.

1.Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.
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To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with teacher data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
Consequences

<Group>

 

 

 

 

 

 

One is required, the
other may be
required

64 If an existing
teacher group is
identified by the
<Group Foreign ID>
value, the teacher
will be assigned to
this teacher group.
The <Group> value
will be disregarded.

If no existing
teacher group is
identified by the
<Group Foreign ID>
value or if no
<Group Foreign ID>
value is specified, a
<Group> value is
required.

If a required
<Group> value is
specified, the
teacher will be
assigned to a newly
created teacher
group identified by
the <Group> value
and, if specified,
the <Group Foreign
ID> value.

If this creation of a
teacher group will
cause a teacher
group Group value
to become
duplicated, the
assignment of the
teacher to a group
will be denied.

If a required
<Group> value is
not specified, the

<Group Foreign ID> 64
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assignment of the
teacher to a
teacher group will
be denied.

<Group Comments> Optional 64 If the teacher is
assigned to an
existing teacher
group, any <Group
Comments> value
will be disregarded.

If the teacher is
assigned to a newly
created teacher
group, any <Group
Comments> value
will become the
teacher group
Comments value.

<Teacher Foreign
ID>

Required 64 If no existing
teacher is identified
by this <Teacher
Foreign ID> value,
the assignment of
the teacher to the
specified teacher
group will be
denied.

Sample data

,E11,”Members of the ‘English’ faculty”,T1001

German Teachers,G15,Sprechen Sie Deutsch,T1055

Physics Teachers,,,T1073

<Group> <Group Foreign
ID>

<Group
Comments>

<Teacher Foreign
ID>

E11 ”Members of the
‘English’ faculty”

T1001

German Teachers G15 Sprechen Sie
Deutsch

T1055

Physics Teachers T1073

Note

Assigning teachers to teacher groups by CSV file specifications will replace all existing
teacher to group assignments in specified teacher groups by imported teacher to group
assignments. Before import, you will be notified which existing teacher to group
assignments will be deleted by import. You will be warned if import deletes teacher to



Class Manager menus and dialog boxes

26

course assignments. If all existing teacher to group assignments in specified teacher
groups shall not be replaced, do not use this method but edit each Teacher Group.

5.1.3 Import Students from File

On the File menu, point to Import From File and then click Students.

Use the Import Teachers from File dialog box to import student data from a CSV file.

1. Create your CSV file according to the import format described in the dialog box and
below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the data
before doing the actual import. Any errors are marked as such and an error message is
shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click Edit
and Import.

To exclude one or more records from the import: Select the records, then right-click
and click Exclude.

Import format

The CSV file with student data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import description

<Student> Required 64 The student name.

If <Student> and
<Student Foreign
ID> are identical to
existing teacher
data, the existing
data will be
overwritten.

If only one of either
<Student> or
<Student Foreign
ID> is identical to
existing teacher
data, the imported
data will result in
new student data.

Note: Identical
Student values for
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different students
are allowed but not
advisable.

<Student Foreign
ID>

Optional 64 This data is used
only if you want
identical <Student>
values for different
teachers.

<Comments> Optional 64

<Windows Logon
Name>

 

 

One of these two
values is required to
uniquely identify the
student.

250 Import always
preserves data
consistency: if an
import would cause
any teacher
Windows Logon
Name or Computer
Name values to
become duplicated,
import will be denied.

<Computer Name> 250

Sample data

Alice A. Anderson,S2001,,AAA,

Bob B. Bellamy,,Hearing disabled,,G74

Chris C. Charlton,S2003,,CCC,N28

<Student> <Student
Foreign ID>

<Comments> <Windows
Logon
Name>

<Computer
Name>

Alice A. Anderson S2001 AAA

Bob B. Bellamy Hearing
impaired

G74

Chris C. Charlton S2003 CCC N28

5.1.4 Import Students to Groups from File

On the File menu, point to Import From File and then click Students to Groups.

Use the Import Students to Groups from File dialog box to import student data into a
group from a CSV file.

Select the One Group tab to assign student to one student group.

Use the Import settings to specify whether you want to import teacher data into
an existing student group or create a new group.

1. Create your CSV file according to the import format described in the dialog box
and below in this topic.
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2.Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with student data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Student Foreign
ID>

Required 64 If no existing
student is identified
by this <Student
Foreign ID> value,
the assignment of
the student to the
specified student
group will be
denied.

Sample data

S1001

S1002

S1003

Select the Multiple Groups tab to assign students individually to multiple
student groups.

1.Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.
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If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with student data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Group>

 

 

 

 

 

 

One is required, the
other may be
required

64 If an existing
student group is
identified by the
<Group Foreign ID>
value, the student
will be assigned to
this student group.
The <Group> value
will be disregarded.

If no existing
student group is
identified by the
<Group Foreign ID>
value or if no
<Group Foreign ID>
value is specified, a
<Group> value is
required.

If a required
<Group> value is
specified, the
student will be
assigned to a newly
created student
group identified by
the <Group> value
and, if specified,
the <Group Foreign
ID> value.

If this creation of a
student group will
cause a student
group Group value
to become
duplicated, the
assignment of the
student to a group
will be denied.

<Group Foreign ID> 64
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If a required
<Group> value is
not specified, the
assignment of the
student to a group
will be denied.

<Group Comments> Optional 64 If the student is
assigned to an
existing student
group, any <Group
Comments> value
will be disregarded.

If the student is
assigned to a newly
created student
group, any <Group
Comments> value
will become the
student group
Comments value.

<Student Foreign
ID>

Required 64 If no existing
student is identified
by this <Student
Foreign ID> value,
the assignment of
the student to the
specified student
group will be
denied.

Sample data

,5GR,,S1001

4th Grade,,”Class Teacher: Dr. Nelson”,S1002

3rd Grade,3GR,,S1003

<Group> <Group Foreign
ID>

<Group
Comments>

<Student Foreign
ID>

5GR S1001

4th Grade ”Class Teacher: Dr.
Nelson”

S1002

3rd Grade 3GR S1003

Note

Assigning students to student groups by CSV file specifications will replace all existing
student to group assignments in specified student groups by imported student to group
assignments. Before import, you will be notified which existing student to group
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assignments will be deleted by import. You will be warned if import deletes student to
course assignments. If all existing student to group assignments in specified student
groups shall not be replaced, do not use this method but edit each student group.

5.1.5 Import Courses from File

On the File menu, point to Import From File and then click Courses.

Use the Import Courses from File dialog box to import teacher data into a group from a
CSV file.

Select the One Group tab to assign courses to one course group.

Use the Import settings to specify the term that courses are to be created in and
to specify whether you want to import course data into an existing course group or
create a new group.

1. Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with course data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Course> Required 32 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
this <Course> value
will replace the
Course value of the
existing course.

If import will not
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replace an existing
course, if this
<Course> value
identifies an
existing course
assigned to the
specified course
group, import will
be denied.

If neither is the
case, a course
identified by this
<Course> value
and, if specified,
the <Course
Foreign ID> value
will be created.

<Course Foreign
ID>

Optional 64 If this <Course
Foreign ID> value
identifies an
existing course
assigned to the
specified course
group, import will
replace the existing
course by the
imported course.

<Comments> Optional 64 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Comments>
value will replace
the Comments
value of the
existing course.

<Background Color> Optional Required format If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Background
Color> value will
replace the
background color
value of the
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existing course.

If the <Background
Color> value format
is invalid, import will
be denied.

<Teacher Foreign
ID>

Optional 64 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Teacher
Foreign ID> value
will replace the
Teacher Foreign ID
value of the
existing course.

If no existing
teacher is identified
by this <Teacher
Foreign ID> value,
import will be
denied.

Note: This value
assigns a main
teacher to the
course. A course
without a main
teacher is invalid.

Sample data

English 1,ENG001,English Level 1,,T1001

English 2,,English Level 2,,

English 3,ENG003,,255:0:0,

<Course
>

<Course
Foreign ID>

<Comments> <Background
Color>

<Teacher
Foreign ID>

English 1 ENG001 English Level 1 T1001

English 2 English Level 2

English 3 ENG003 255:0:0

Select the Multiple Groups tab to assign courses individually to multiple course
groups.

Use the Import settings to specify the term that courses are to be created in.
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1.Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with course data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Course> Required 32 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
this <Course> value
will replace the
Course value of the
existing course.

If import will not
replace an existing
course, if this
<Course> value
identifies an
existing course
assigned to the
specified course
group, import will
be denied.

If neither is the
case, a course
identified by this
<Course> value
and, if specified,
the <Course
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Foreign ID> value
will be created.

<Course Foreign
ID>

Optional 64 If this <Course
Foreign ID> value
identifies an
existing course
assigned to the
specified course
group, import will
replace the existing
course by the
imported course.

<Comments> Optional 64 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Comments>
value will replace
the Comments
value of the
existing course.

<Background Color> Optional Required format If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Background
Color> value will
replace the
background color
value of the
existing course.

If the <Background
Color> value format
is invalid, import will
be denied.

<Teacher Foreign
ID>

Optional 64 If import will
replace an existing
course, see the
import
consequences of
the <Course
Foreign ID> value,
any <Teacher
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Foreign ID> value
will replace the
Teacher Foreign ID
value of the
existing course.

If no existing
teacher is identified
by this <Teacher
Foreign ID> value,
import will be
denied.

Note: This value
assigns a main
teacher to the
course. A course
without a main
teacher is invalid.

<Course Group> Optional 32 If an existing
course group is
identified by the
<Course Group>
and/or <Course
Group Foreign ID>
values, the course
will be assigned to
it.

If one existing
course group is
identified by the
<Course Group>
value and another
existing course
group is identified
by the <Course
Group Foreign ID>
value, the course
will be assigned to
the course group
identified by the
<Course Group>
value.

If no existing
course group is
identified by the
<Course Group>
value or the
<Course Group
Foreign ID> value,
if a <Course Group>
value is specified
the course will be

<Course Group
Foreign ID>

Optional 64
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assigned to a newly
created course
group identified by
the <Course Group>
value and, if
specified, the
<Course Group
Foreign ID> value.
If no <Course
Group> value is
specified, the
course will be
assigned to the
default course
group.

If no <Course
Group> or <Course
Group Foreign ID>
values are
specified, the
course will be
assigned to the
default course
group.

Sample data

English 1,ENG001,,255:0:0,T1001,English,CGENG

German 1,GER001,,0:255:0,,,CGGER

Physics 1,PHY001,Mechanics,,,Physics,CGPHY

<Course
>

<Course
Foreign
ID>

<Comme
nts>

<Backgro
und
Color>

<Teacher
Foreign
ID>

<Course
Group>

<Course
Group
Foreign
ID>

English 1 ENG001 255:0:0 T1001 English CGENG

German 1 GER001 0:255:0 CGGER

Physics 1 PHY001 Mechanics Physics CGPHY

5.1.6 Import Members to Courses from File

On the File menu, point to Import From File and then click Members to Courses
from File.

Use the Import Members to Courses from File dialog box to import course and course
members data from a CSV file.

Note 

It is a prerequisite for a successful import  that the courses 
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1.Create your CSV file according to the import format described in the dialog box and
below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the data
before doing the actual import. Any errors are marked as such and an error message is
shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click Edit
and Import.

To exclude one or more records from the import: Select the records, then right-click
and click Exclude.

Import format

The CSV file with course and course members data must have the right format for the
import to be successful. The table below describes the format and the small set of sample
data following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import description

<Course Foreign ID> Required 64 If no existing course
is identified by the
<Course Foreign ID>
value, import will be
denied.

<Member Foreign
ID>

Required 64 If no existing
teacher, teacher
group, student or
student group is
identified by the
<Member Foreign ID>
value, import will be
denied.

<To set as Main
Teacher>

Optional Required format Format options are *
(Yes) or <Anything
else, typically blank>
(No).

If multiple teachers
are set as main
teacher, the last one
in the file will
become main
teacher.

Sample data

ENG001,English Level 1,
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ENG001,T1001,*

GER001,5GR,

<Course Foreign ID> <Member Foreign  ID> <To set as Main Teacher>

ENG001 English Level 1

ENG001 T1001 *

GER001 5GR

5.1.7 Import Classrooms from File

On the File menu, point to Import From File and then click Classrooms.

Use the Import Classrooms from File dialog box to import classroom data into a group
from a CSV file.

Select the One Group tab to create classrooms assigning them to one
classroom group.

Use the Import settings to specify whether you want to import classroom data into
an existing classroom group or create a new group.

1. Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with classroom data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Classroom> Required 32 If import will
replace an existing
classroom, see the
import



Class Manager menus and dialog boxes

40

consequences of
the <Foreign ID>
value, this
<Classroom> value
will replace the
Classroom value of
the existing
classroom.

If import will not
replace an existing
classroom, if this
<Classroom> value
identifies an
existing classroom
assigned to the
specified classroom
group, import will
be denied.

If neither is the
case, a classroom
identified by this
<Classroom> value
and, if specified,
the <Foreign ID>
value will be
created.

<Classroom Foreign
ID>

Optional 64 If this <Foreign ID>
value identifies an
existing classroom
assigned to the
specified classroom
group, import will
replace the existing
classroom by the
imported classroom.

Sample data

A1,CLRA001

A2,

A3,CLRA003

Select the Multiple Groups tab to create classrooms assigning them
individually to multiple classroom groups.

1.Create your CSV file according to the import format described in the dialog box
and below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the
data before doing the actual import. Any errors are marked as such and an error
message is shown along with the data.
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3.Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click 
Edit and Import.

To exclude one or more records from the import: Select the records, then right-
click and click Exclude.

Import format

The CSV file with classroom data must have the right format for the import to be
successful. The table below describes the format and the small set of sample data
following the table follows the format requirements.

Value Required or
Optional

Max # of
characters

Import
description

<Classroom> Required 32 If import will
replace an existing
classroom, see the
import
consequences of
the <Foreign ID>
value, this
<Classroom> value
will replace the
Classroom value of
the existing
classroom.

If import will not
replace an existing
classroom, if this
<Classroom> value
identifies an
existing classroom
assigned to the
specified classroom
group, import will
be denied.

If neither is the
case, a classroom
identified by this
<Classroom> value
and, if specified,
the <Foreign ID>
value will be
created.

<Classroom Foreign
ID>

Optional 64 If this <Foreign ID>
value identifies an
existing classroom
assigned to the
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specified classroom
group, import will
replace the existing
classroom by the
imported classroom.

<Group> Optional 32 If an existing
classroom group is
identified by the
<Group> and/or
<Group Foreign ID>
values, the
classroom will be
assigned to it.

If one existing
classroom group is
identified by the
<Group> value and
another existing
classroom group is
identified by the
<Group Foreign ID>
value, the
classroom will be
assigned to the
classroom group
identified by the
<Group> value.

If no existing
classroom group is
identified by the
<Group> value or
the <Group Foreign
ID> value, if a
<Group> value is
specified the
classroom will be
assigned to a newly
created classroom
group identified by
the <Group> value
and, if specified,
the <Group Foreign
ID> value. If no
<Group> value is
specified, the
classroom will be
assigned to the
default classroom
group.

If no <Group> or
<Group Foreign ID>
values are

<Group Foreign ID> Optional 64
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specified, the
classroom will be
assigned to the
default classroom
group.

Sample data

A1,CLRA001,,

A2,,New,CLRG2

A3,CLRA003,,CLRG1

<Classroom> <Classroom
Foreign ID>

<Group> <Group Foreign
ID>

A1 CLRA001

A2 New CLRG2

A3 CLRA003 CLRG1

5.1.8 Import Lessons from File

On the File menu, point to Import From File and then click Lessons from File.

Use the Import Lessons from File dialog box to import teacher data from a CSV file.

1. Create your CSV file according to the import format described in the dialog box and
below in this topic.

2. Click Browse to locate and open the CSV file.

Initially the CSV file content displays in the dialog box so that you can review the data
before doing the actual import. Any errors are marked as such and an error message is
shown along with the data.

3. Click Import to import the data. 

Imported records will be removed from the table while error records with a red
background remain in the table.

If you want to edit the data before you import, right-click a record and then click Edit
and Import.

To exclude one or more records from the import: Select the records, then right-click
and click Exclude.

Import format

The CSV file with lesson data must have the right format for the import to be successful.
The table below describes the format and the small set of sample data following the table
follows the format requirements.

Value Required or
Optional

Max # of
characters

Import description
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<Course Foreign ID> Required 64 If no existing course
is identified by this
<Course Foreign ID>
value, import will be
denied.

<Classroom Foreign
ID>

Required 64 If no existing
classroom is
identified by this
<Classroom Foreign
ID> value, import will
be denied.

<Lesson Date> Required Required format Required date
format: YYYYMMDD.
If an invalid <Lesson
Date> value is
specified, import will
be denied.

<Lesson Start Time> Required Required format Required time
format: HHMM . If an
invalid <Lesson Start
Time> or <Lesson
End Time> value is
specified, import will
be denied.

<Lesson End Time> Required Required format

<Teacher Foreign
ID>

Required 64 If no existing
teacher is identified
by this <Teacher
Foreign ID> value,
import will be denied.

<Lesson Foreign ID> Optional 64 If an existing lesson
is identified by this
<Lesson Foreign ID>
value, import will
replace it by the
imported lesson.

If no existing lesson
is identified by this
<Lesson Foreign ID>
value or if no
<Lesson Foreign ID>
value is specified,
import will create a
lesson identified by
this <Lesson Foreign
ID> value, if
specified.

Sample data

ENG001,CLRA001,20050310,0800,0845,T1001,9985AD47
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GER001,CLRA001,20050310,0900,0945,T1002,

PHY001,CLRA001,20050310,1000,1045,T1007,

<Course
Foreign
ID>

<Classroo
m
Foreign
ID>

<Lesson
Date>

<Lesson
Start Time>

<Lesson
End
Time>

<Teacher
Foreign
ID>

<Lesson
Foreign
ID>

ENG001 CLRA001 20090310 0800 0845 T1001 9985AD47

GER001 CLRA001 20090310 0900 0945 T1002

PHY001 CLRA001 20090310 1000 1045 T1007

5.2 Components menu

This menu contains these commands:

Term

Teacher

Teacher Group

Student

Student Group

Course

Course Group

Classroom

Classroom Group

Timetable

5.2.1 Term

On the Components menu, click Term. Alternatively, click the Term button on the
toolbar.

Use the Term dialog box to create new terms, and to edit or delete existing ones.

A term specifies a date interval in which courses can be specified and in which lessons
can be scheduled.
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The name of the current term is displayed in the Term list to the right in the Netop Class
Manager window. The term date interval determines the range of the term calendar.

A term can support one of two class modes that you can switch at any time.

Click New to create a new term.

About creating a new term

A term name must be unique among all terms.

The term start date must be before the end date. You cannot create a term with an
end date in the past. Terms cannot overlap.

Determine the level of freedom teachers should have with respect to running classes: 

Provide course names only means that teachers can run any class, and that only
courser need to be defined. Classroom, timetable and lesson information will be
inactive. 

Provide scheduled lessons only means that teachers can run only classes that are
scheduled to start at the specified time. Classroom, timetable and lesson information
will be active.

5.2.2 Teacher

On the Components menu, click Teacher. Alternatively, click the Teacher button on
the toolbar.

Use the Teacher dialog box to create new teacher data, and to edit or delete existing
data. 

Existing teachers and teacher groups are available in all terms for being assigned to
courses.

Click New to create new teacher data.

Note that teacher data can also be created by importing from an external CSV file; for
more information see Import Teachers from File.

About creating new teacher data

Field Description

Teacher The teacher name.

Note that duplicate teacher names are allowed but not
recommended.

Foreign ID Optional field. 

Note that the Foreign ID must be unique among teachers,
teacher groups, students and student groups.

Comments Optional. Any textual comments related to the teacher.

Windows logon name,
Computer name,
Teacher profile

The name the teacher uses to log on to the teacher
computer.
The computer name of the Teacher computer.
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Field Description

The name the teacher uses to log on to a teacher profile.

Only one of these values is required. Each of these values
must be unique among all teachers.

View additional information about a teacher

In the Teacher dialog box, right-click any teacher data and select View Courses or
View Groups.

View Courses provides information about courses to which the selected teacher is
assigned. The information in the dialog box is for viewing only. Manage the assignment of
teachers and teacher groups to a course in the Edit Course dialog box.

View Groups provides information about teacher groups to which the selected teacher is
assigned. The information in the dialog box is for viewing only. Manage the assignment of
teachers to a teacher group in the Edit Teacher Group dialog box.

5.2.3 Teacher Group

On the Components menu, click Teacher Group. 

Use the Teacher Group dialog box to create new groups, and to edit or delete existing
ones.

Existing teachers and teacher groups are available in all terms for being assigned to
courses.

Click New to create a new group.

Note that you can also create teacher groups while assigning teachers to teacher groups
by import from an external data source, see Import Teachers to Groups from File.

About creating new teacher groups

Teacher data needs to be available before you can create teacher groups.

Field Description

Group The teacher group name

Note that a teacher group name must be unique among all
teacher groups.

Foreign ID Optional field. 

Note that a foreign ID value must be unique among teachers,
teacher groups, students and student groups.

Comments Optional. Any textual comments related to the teacher group.

To add a teacher to the group:

In the Available teachers list, right-click a teacher row and click Assign Selected to
Group.
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To remove a teacher from the group:

In the Teachers in group list, right-click a teacher row and click Unassign Selected
from Group.

Alternatively you can use a drag-and-drop operation to either add or remove.

View additional information about a teacher group

In the Teacher Group dialog box, right-click any teacher data and select View Teachers
.

View Teachers displays teachers assigned to the selected teacher group.

5.2.4 Student

On the Components menu, click Student. Alternatively, click the Student button on
the toolbar.

Use the Student dialog box to create new student data, and to edit or delete existing
data. 

Existing students and student groups are available in all terms for being assigned to
courses.

Click New to create new student data.

Note that student data can also be created by importing from an external CSV file; for
more information see Import Students from File.

About creating new student data

Field Description

Student The student name.

Note that duplicate student names are allowed but not
recommended.

Foreign ID Optional field. 

Note that the Foreign ID must be unique among teachers,
teacher groups, students and student groups.

Comments Optional. Any textual comments related to the teacher.

Windows logon name,
Computer name,
Student login name

The name the teacher uses to log on to the computer.
The computer name of the Student computer.
The name the student uses to log on to the Student module.

Only one of these values is required. Each of these values
must be unique among all students.

View additional information about a student

In the Student dialog box, right-click any teacher data and select View Courses or
View Groups.

View Courses provides information about courses to which the selected student is
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assigned. The information in the dialog box is for viewing only. Manage the assignment of
students and student groups to a course in the Edit Course dialog box.

View Groups provides information about student groups to which the selected student is
assigned. The information in the dialog box is for viewing only. Manage the assignment of
students to a student group in the Edit Student Group dialog box.

5.2.5 Student Group

On the Components menu, click Student Group. Alternatively, click the Student
Group button on the toolbar.

Use the Student Group dialog box to create new groups, and to edit or delete existing
ones.

Existing students and student groups are available in all terms for being assigned to
courses.

Click New to create a new group.

Note that you can also create student groups while assigning students to student groups
by import from an external data source, see Import Students to Groups from File.

About creating new student groups

Student data needs to be available before you can create teacher groups.

Field Description

Group The student group name

Note that a student group name must be unique among all
student groups.

Foreign ID Optional field. 

Note that a foreign ID value must be unique among teachers,
teacher groups, students and student groups.

Comments Optional. Any textual comments related to the student group.

To add a student to the group:

In the Available students list, right-click a teacher row and click Assign Selected to
Group.

To remove a student from the group:

In the Students in group list, right-click a teacher row and click Unassign Selected
from Group.

Alternatively you can use a drag-and-drop operation to either add or remove.

View additional information about a student group

In the Student Group dialog box, right-click any student data and select View Students
.

View Students displays students assigned to the selected student group.
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5.2.6 Course

On the Components menu, click Course. Alternatively, click the Course button on the
toolbar.

Use the Course dialog box to create new courses, and to edit or delete existing courses.
At least one term and one teacher must exist before it is possible to create a course. 

A course is always assigned to a course group; for information about course groups, see 
Course Groups.

Existing courses are available only in the term in which they were created.

Click New to create a new course.

Note that courses can also be created by importing from an external CSV file; for more
information see Import Courses from File. You can also assign members to courses by
import from an external data source, see Import Members to Courses from File.

About creating a new course

Field Description

Course The course name.

Note that a course name must be unique among courses in a course
group.

Foreign ID Optional field.

Note that a foreign ID value must be unique among all courses.

Group The group that the course belongs to. 

Click the New Group button to create a new group if none of the existing
groups are suitable.

Term The term in which the course exists.

Main Teacher The name of the teacher that is assigned to this course as main teacher.

The list of teacher names to choose from is empty until one or more
teachers have been assigned to the course.

Comments Optional. Any textual comments related to the course.

Background
Color

The course color as it will appear in the Class Manager main window.

Using different colors for different course makes it easier to differentiate
between them. Depending on the color selected, white text or black text
may be the best choice.

Use the Students and Teachers tabs to assign to the course. You can assign Students
and Teachers individually or as member of a group.

To add to the course:
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In the Available students or the Available teachers list, right-click a row and click
Assign Selected to Course.

To remove from a course:

In the Students in course or the Teachers in course list, right-click a row and click
Unassign Selected from Course.

Note that you cannot individually unassign students or teachers that were assigned as
members of a group.

View lessons and assign a teacher

In the Courses dialog box, select a course and click the Lessons button.

The lesson status can be one of the following:

Completed (green background): The lesson with a running class has ended.

Passed (gray background): The lesson with no running class has ended.

Not Completed (white background): The lesson has not ended.

If Class Manager has not recently been refreshed, a recently completed or passed lesson
may display Not Completed. To refresh: On the Tools menu, click Refresh.

The drop-down list beneath the list of lessons holds all teachers assigned to the course.
The name of the main teacher displays by default.

For lessons that have status Not Complete, you can assign a new teacher by clicking
Assign Teacher to Lessons.

5.2.7 Course Group

On the Components menu, click Course Group. 

Use the Course Group dialog box to create new groups, and to edit or delete existing
ones.

A course is always assigned to a course group.

The names of the available course groups as well as courser in each group are displayed
in the Courses list to the right in the Netop Class Manager window. 

Existing course groups are available in all existing terms. Note that this is not the case for
courser which are available only in the term in which they were created.

Click New to create a new group.

Note that you can also create courses in course groups by import from an external data
source, see Import Courses from File.

About creating course groups

Field Description

Group The group name.

Note that a course group name must be unique among all
course groups.
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Field Description

Initially, a default course group named Default Group exists.
It can be renamed, but it always remains the default
classroom group. It cannot be deleted.

Foreign ID Optional field.

5.2.8 Classroom

On the Components menu, click Classroom. Alternatively, click the Classroom
button on the toolbar.

Use the Classroom dialog box to create new classroom data, and to edit or delete
existing data.

A Netop Class Manager classroom typically refers to a physical classroom with teacher
computers and student computers that can connect for teachers and students to engage
in educational activities in lessons. However, a Netop Class Manager classroom can also
refer to a virtual classroom where teacher computers and student computers in different
physical locations can connect.

A classroom is always assigned to a classroom group.

The names of the available classrooms are displayed in the Classrooms list to the left in
the Netop Class Manager window. 

Existing classrooms are available in all terms for scheduling lessons.

Click New to create a new classroom.

Note that you can also create classrooms in classroom groups by import from an external
data source, see Import Classrooms from File.

About creating a new classroom

Field Description

Classroom The classroom name.

Note that a classroom name must be unique among classrooms in a
classroom group.

Foreign ID Optional field.

Note that a foreign ID value must be unique among all courses.

Group The group that the classroom belongs to. 

Click the New Group button to create a new group if none of the existing
groups are suitable.
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5.2.9 Classroom Group

On the Components menu, click Classroom Group. 

Use the Classroom Group dialog box to create new groups, and to edit or delete existing
ones.

A classroom is always assigned to a classroom group.

The names of the available classrooms are displayed in the Classrooms list to the left in
the Netop Class Manager window. Note that by default classroom groups are not shown.
To show classroom groups:

Right-click the Classroom list area and click Show Groups on the shortcut menu.

Click New to create a new group.

Note that you can also create classrooms in classroom groups by import from an external
data source, see Import Classrooms from File.

About creating a new classroom group

Field Description

Group The group name.

Note that a classroom group name must be unique among all
classroom groups.

Initially, a default course group named Default Group exists.
It can be renamed, but it always remains the default
classroom group. It cannot be deleted.

Foreign ID Optional field.

5.2.10 Timetable

On the Components menu, click Timetable. Alternatively, click the Timetable button
on the toolbar.

Use the Timetable dialog box to create a new timetable, and to edit or delete existing
timetables. 

What is a time table in Netop Class Manager?

A timetable in Netop Class Manager defines a number of time slots for lessons and
the intervals between the lessons within a daily start and end time; for example:

8:00-8:45 Module 1

8:45-8:55 Break

8:55-9:40 Module 2

9:40-9:50 Break

9:50-10:35 Module 3
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10:35-10:45 Break

10:45-11:30 Module 4

11:30-12:00 Lunch break

12:00-12:45 Module 5

12:45-12:55 Break

12:55-1:40 Module 6

1:40-1:50 Break

1:50-2:35 Module 7

2:35-2:45 Break

2:45-3:30 Module 8

3:30-3:40 Break

3:40-4:25 Module 9

Multiple timetables can exist and one of them is applied. The applied timetable determines
the default time range in Netop Class Manager.

A timetable can specify fixed lesson schedules to which new lessons will be aligned;
existing lessons can also be aligned to a timetable.

Existing timetables are available in all terms for scheduling lessons.

Click New to create a new timetable.
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About creating a new timetable

Field Description

Timetable properties Timetable name, start and end time.

Initially, a timetable named Default Group exists and is
applied. The timetable starts at 8 A.M. and ends at 4 P.M.

Lesson schedule
properties

Initially, no lesson schedules exist. To create a lesson
schedule, follow these steps:

1. In the Lesson length and Recess length fields, set the
typical values that you use for lessons and lesson breaks,
foe example 00:45 and 00:15.

2. Click New to create a fixed lesson schedule starting at the
earliest available time. The fixed lesson schedule will be
displayed as a blue block in the graphical section.

3. In the Lesson schedule field, optionally specify a name, for
example Lesson 1.

4. If required, adjust the start and end times of the fixed
lesson schedule.

Repeat steps 2 to 4 until all desired lesson schedules have
been created.

5.3 Tools Menu

This menu contains these commands:

Database Management

Refresh

Clean Up Database

Show Toolbar

5.3.1 Database Management

On the Tools menu, click Database Management.

Use the Database Management dialog box to manage the class database.

The dialog box has three tabs:

Connection tab

Use this tab to manage the class database connection.



Class Manager menus and dialog boxes

56

Database connection

Change Open Windows' Data Link Properties window to specify a database
connection and connect to it.

Use Test
Database

Connect to the test database.

Using: The name of the connected database.

Database connection status

Query
Status

Refresh the class database connection status in the field below.

Reconnect Disconnect from and connect to the connected to class database.

Database connect string

The field displays the currently specified class database connect
string. You can edit the string.

Update tab

Use this tab to manage updates of the class database.

Update database

Update Update the class database. When the class database has been
updated successfully, a message to that effect is displayed.

Notes

When Netop Class Manager loads, it checks the class database. If no
database messages are displayed at loading, the class database is
updated. You should update the class database only if you are
notified that it needs updating.

Updating the class database using the Update button will not harm
the data in the class database.

Updating the class database may require database administrator
rights.

View advanced details

View Table
Errors

Display class database table errors in a right pane expansion of the
window.

View SQL
Statements

Display SQL statements required to update the class database in a
right pane expansion of the window.

Note  Viewing table errors or SQL statements does not require write
rights in the class database.
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Tip  Right-click the window that opens to display the popup command
Copy All. Select this command to copy the pane contents to the
clipboard.

Advanced tab

Use this tab to manage class database optimization options.

Optimize Options

Use SQL
Batch to
increase
performanc
e

Netop Class Manager prefers to use SQL Batch collecting multiple SQL
statements in one block to increase performance. If you experience
performance problems and this option was for some reason not
selected, select it to see if Netop Class Manager is able to use this
optimization type. You will get a warning if not. In that case, leave
the box cleared.

5.3.2 Refresh

On the Tools menu, click Refresh.

Use Refresh to retrieve new data from the class database to update window contents.

This is useful in the situations when updates do not happen automatically which could be
the case when the class database contents has been changed from another Netop Class
Manager.

5.3.3 Clean Up Database

On the Tools menu, click Clean Up Database.

Use Clean Up Database to remove class data of a term that has ended to reduce its
size. If no terms exists that has ended, the Term list is empty and database cleanup is
not possible.

5.3.4 Show Toolbar

On the Tools menu, click Show Toolbar to switch between showing and hiding the
toolbar.
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6 Class Server window

6.1 Netop Class Server window

If class server functionality has been set up, loading Netop Class Server will display this
icon in the notification area in the lower right corner of the screen:

Double-click the icon to display this window:

Except for the window name, this window exactly matches the Netop Host window
because Netop Class Server is an extended Netop Host with the additional ability to
service Netop School module class requests to a class database.

On the Tools menu, click Class Server Setup to open the Class Server Setup window.

The default communication setup of Netop Class Server enables it to service Netop School
modules on its local network segment using a default communication setup.

If Netop Class Server is to service Netop School modules beyond its local network
segment and Netop School modules that use a non-default communication setup,
communication adjustments are required.

Note: To respond quickly, Netop Class Server stores class information in cache memory
that is refreshed automatically once every hour. To apply class database class information
changes immediately, restart Netop Class Server.

Netop Class Server cannot service a Netop School module running on its own computer.

Communication adjustments

If Netop Class Server is to service Netop School modules beyond its local network
segment and Netop School modules that use a non-default communication setup,
communication adjustments are required.

On the Tools menu, click Communication Profiles:
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By default three communication profiles are enabled:

Class Server TCP/IP profile Netop School communication profile, default port 1971.

LAN (TCP) Netop Remote Control network point-to-point communication
profile, default port 6502.

TCP/IP Netop Remote Control networking communication profile,
default port 6502.

Refer to the Host documentation or to the Netop School Advanced User's Guide for details
about the communication profiles.

When communication has been adjusted, restart Netop Class Server to apply changes.
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